Module 2 Chapter 1
SSIS – General Navigation

Module 2 consists of two chapters:
1. SSIS: General Navigation
2. Time Entry: The User Activity Log and Chronology

Chapter 1: SSIS – General Navigation

Overview
Chapter 1 consists of five sections:
1. SSIS: The Social Services Information System
2. Basic Navigation Tools
3. SSIS as a Case Management Tool
4. Timeline and Entry Requirement Tools
5. SSIS Learning Resources.

When you have completed Chapter 1, you are able to:
• Describe SSIS
• Understand the purpose of SSIS
• Recognize the importance of accurate and timely data entry
• Log on and access SSIS applications
• Utilize Toolbars, Task Panels, and the Action Menu
• Use SSIS Help functions
• Identify cases, workgroups and participants
• Perform a search
• Use alerts, reminders, data clean-up and mandatory field indicators to manage timelines
• Locate and use SSIS learning resources.

SSIS: The Social Services Information System

This section provides a basic understanding of:
• The purpose of SSIS
• How you use SSIS
• The impact of data you enter in SSIS.

Minnesota developed and currently uses a Statewide Automated Child Welfare Information System, or SACWIS, to collect and manage information necessary to facilitate the delivery of child welfare services. Minnesota’s SACWIS is named Social Services Information System, or SSIS.

SSIS is a case management and data collection system developed with case workers for case workers. SSIS represents a partnership of agency and state professionals collaborating to help
Minnesota child welfare workers manage caseloads and reduce paperwork in order to spend more time with children, youth and families.

- You and other Social Services workers at the county and tribal levels use SSIS to enter case data and to assist in case management.

More than 6000 Minnesota county and tribal agency professionals use SSIS, including:

- Case workers
- Supervisors, managers and directors
- Case aides
- Clerical staff
- Fiscal (accounting) staff
- DHS staff.

SSIS helps county and tribal social workers assist individuals in all 16 DHS program areas, including:

- Child Protection
- Children’s Mental Health
- Family Preservation and support services
- Adoption
- Out-of-Home Care (foster care, kinship care, group homes, residential treatment, emergency shelters)
- Adolescent Independent Living Skills
- Minor Parents
- Adult Protection
- Developmental Disabilities
- Other DHS program areas.

As you work with children, youth and families, you must accurately document all significant client information and case-related events in SSIS including client demographics, intake, assessment, casework activities, placements, court involvement, case plans, federal Title IV-E eligibility, and case closure.

Each agency sets its own policies regarding data entry. Check with your supervisor for any agency-specific data entry requirements.

Your accuracy and timeliness in data entry has far-reaching ramifications.

Data you enter into SSIS is used by DHS to create reports mandated by the federal government. The federal government, in turn, uses reports to determine child welfare policies and funding.

Policies and funding affect county and tribal provision of service to children, youth and families.

Let’s take a closer look at the uses and benefits of data entered into SSIS.
The SSIS cycle starts with you. SSIS allows you to efficiently search for information and record contacts, case notes, service plans, letters and documents, and track timelines and financial responsibilities for children and families.

SSIS documented case history allows for more effective delivery of social services.

The Minnesota Department of Human Services (DHS) uses SSIS data to plan services, improve access to resources, and report required federal data.

The primary Minnesota programs using SSIS data are:
- Minnesota Safety, Permanency, and Child Well-being Outcomes for the Minnesota Child and Family Services Reviews (MnCFSR)
- MAXIS – helps workers to determine Title IV-E foster care eligibility
- Children and Community Services Act (CCSA) – a legislative mandate requiring agencies to provide fiscal and client data, including the Client Summary Report (CSR) and the Social Services Expenditure and Grant Reconciliation Report (SEAGR)
- Minnesota County Human Services Report – provides data on children in out-of-home placement.

And as you saw earlier, DHS uses SSIS data to comply with federal reporting requirements. SSIS complies with federal requirements for accurate and timely reporting and provides data to the federal government through:
- Adoption and Foster Care Analysis Reporting System (AFCARS), for placement and adoption data
- National Child Abuse and Neglect Data System (NCANDS), for child abuse and neglect statistics and related case level information
- Title IV-E of the Social Security Act, for reimbursement for counties and some tribes to help cover out-of-home placement costs
- Federal Safety, Permanency, and Child Well-being Outcomes for Child and Family Services Reviews (CFSR)
- Child Welfare Targeted Case Management (CW-TCM) – A federally funded reimbursement program to help children and families gain access to needed services
- National Youth in Transition Database (NYTD) – for collection of case-level information on youth in care who receive Chafee Foster Care Independence Program (CFCIP) funded independent living services, as well as the outcome information on youth who are in or who have aged out of foster care.

In addition, data from SSIS helps to drive federal funding and national child welfare policy.

County and tribal social service agencies use SSIS data to:
- Improve the function and efficiency of services
- Automate routine tasks
- Support social work best practices
• Access timely information on families, including alleged victims of maltreatment, children in foster care, and children waiting for adoption
• Determine client needs
• Expedite delivery of services to children, youth and families.

Further, funding levels and policy are determined in part as a direct result of SSIS data.

Children, youth and families benefit from SSIS with streamlined methods for delivery of services, detailed documentation, and better communication among professionals in different program areas serving the same family.

Summary

SSIS is the statewide case management and data collection system you use as a social services worker.

Data you enter into SSIS is critical to:
• Provision of timely and appropriate services to children and families
• Data reporting to state and federal agencies
• Policy development at the state and federal levels
• Funding of social services.

Basic Navigation Tools

SSIS may look very complex to you at first. Be assured that with time and experience you will become very familiar with SSIS functions. We’re going to start with basic SSIS navigation.

In this section you learn to:
• Log on to SSIS
• Change your password
• Use the Standard Windows Toolbar
• Use the Task panel
• Customize your view
• Find Help
• Locate and use:
  - The Application Toolbar
  - The Tree View Toolbar
  - The Action Menu.

Log on to SSIS
• To log on, double click the SSIS Worker icon on your desktop.
• Your User ID is assigned to you by your system administrator.
• Enter your User ID and Password. Click OK.

Change Your Password

You receive a default password from your SSIS Mentor or Coordinator. After logging on for the first time, change your password to something easy to remember.
To change your password:

- Select File from the Windows Toolbar.
- Select Change Password.
- The Change Password dialog box displays with your current User Name autofilled.
- Enter your old password in the Old Password field.
- Enter a new password in the New Password field.
- Confirm your new password.
- Click OK.

SSIS requires you to change your password every 30 days. A message displays indicating how many days remain before you must change your password.

**SSIS Main Screen**

Logging onto SSIS is the first step. Now that you are logged in, the main screen of the Worker/Fiscal application displays, allowing you to navigate to other pieces of the application.

The SSIS banner at the top of the screen identifies the piece of the application you are logged on to, and the version of SSIS.

There are different pieces of the application that you may or may not see depending on your job duties. These include SSIS Worker/Fiscal, Administration, Adoptions, Analysis and Charting, Push/Pull, and Repository. The components of SSIS that you use depend on your position within your agency. For instance, SSIS Adoptions is a function only available to authorized state users.

Access other pieces of the application from the Tools menu. For now, our focus is on the Worker/Fiscal piece of the application.

Below the SSIS banner is the Standard Windows Toolbar; immediately below that is the SSIS Application Toolbar.

The Status Bar on the bottom of any of the main screens verifies the name of the local agency, the application and the user logged on.

Based on a worker’s job functions, the main screen may display the Task Panel automatically. The Task Panel appears to the left of your screen and includes all searches and state reports.

**Toolbars**

Let’s take a look at the different toolbars and toolbar menu options in SSIS. Toolbars allow you to access and add information.

There are three toolbars:

- Windows Toolbar
- SSIS Application Toolbar
- Tree View Toolbar.
**Standard Windows Toolbar**
Below the SSIS banner is the Standard Windows Toolbar.

**File Menu**
The first option within the Windows toolbar is the File menu. The File menu allows you to create a New Reminder, Log on and Log Off, Change Password, and Exit the application.

The Utilities submenu allows users to do maintenance functions in SSIS. We won’t be going into detail about these functions and recommend you talk to your SSIS coordinator or mentor to learn more.

**View Menu**
As a user, you can change the appearance of your screen based on personal preference. The View menu allows you to customize your view in SSIS by selecting or deselecting screen elements. For example, if you prefer not to display the status bar, you can deselect it.

Another way you can customize your view of SSIS is to add or remove the Task Panel from display:
1. Select View in the Windows Toolbar.
2. Click on the Task Panel.
3. The task panel displays.
4. When you click on a task, that section of the Task Panel expands and displays additional menu selections. For example, clicking on the MNYTD Searches task displays all of the MNYTD search options.
5. And if you no longer want to see the Task Panel, remember to select View and click on Task Panel to de-select it.

The View menu allows you to customize Tree Settings, such as having icons display larger or showing a “bread crumb trail” indicating where you have been in the Tree View.

Additionally, the Tree Style submenu allows users to select between viewing the tree view in standard Windows format or in an XP format.

The Searches/Logs menu includes all searches, logs and state reports available. Frequently used searches and logs are represented by icons.

Note that some menu items display submenus, indicated by a right arrow.

**Tools Menu**
From the Tools drop-down menu, other SSIS functions display depending on your security settings and job functions. Check with your SSIS Coordinator or Mentor to determine your security settings.
General Reports are available from the Tools menu. To learn about specific reports, refer to the General Reports module on the SSIS Training Website.

The Window menu displays all currently open SSIS screens. Use this menu to close one or all screens. Or, have them display one on top of the other, for easier viewing and navigation between screens by selecting the Cascade option. You can also navigate to a particular open window by selecting that window in the list.

**Help Menu**
The Help menu links you to SSIS Help; you’ll learn more about Help later in this chapter.

**SSIS Application Toolbar**
Directly below the Windows Toolbar is the SSIS Application Toolbar.

The SSIS Application Toolbar icons display for Log On and Log Off, User Activity Log, User Reminders/Alerts, Service Arrangement Searches, Payment Searches, Person Search, Business Organization Search, Workgroup Search, Intake Search and Contents.

To identify the Application Toolbar icons, hold your cursor over the icon – a flyover displays with the name of the search or log.

**Tree View Toolbar**
The Tree View Toolbar, located under the Application Toolbar, displays once you have opened a Case, Intake or Workgroup, and many searches. This toolbar displays icons that are specific to the current screen.

**Quick Add Buttons**
The Tree View toolbar also displays Quick Add buttons. The item highlighted on the Tree View determine the Quick Add buttons available in the Tree View Toolbar. Quick Add buttons allow workers access to commonly performed functions from that location.

**Hints and Shortcuts**
If something is not displaying correctly, try the Refresh button.

If you have accessed a screen in error, or inadvertently entered incorrect information, use the Cancel button to cancel all changes or back out of the screen.

**Slider Bars**
Many screens in the SSIS program have slider bars to allow you to move the screen horizontally or vertically. This can be helpful when you need to either see more or less information on your screen.

Workers can inadvertently double-click on a slider bar, causing the Tree View or other areas of the screen to be hidden from view. Look on your screen for a slider bar if you are not seeing what you expect to display on that screen.
Keyboard Shortcuts
Since many users prefer to use the keyboard instead of the mouse, SSIS has keyboard shortcuts. The underlined letters that are highlighted show examples of some of the available keyboard shortcuts.

Keyboard shortcuts appear within various Action menus. For example, to enter a New Primary Worker from the workgroup node in the Tree View, access the action menu and press the Shift key and the letter N on your keyboard.

The Tree View
Use the Tree View as the primary navigation mode; it displays to the left of almost every screen in SSIS.

The Tree View is composed of folders and nodes. Folders display as a manila folder. Nodes are all other icons you see in the Tree View.
- Staff Assignments and Participants are examples of folders.
- Workgroup and Client are examples of nodes.

Click on the plus sign to expand folders and nodes, and to display sub-folders and sub-nodes. Collapse folders and nodes by clicking on the minus sign.

Highlight or click on a folder or node on the Tree View to display a detail panel on the right side of your screen.

A grid displays on the right side of your screen to display items that exist within a folder or node in the Tree View. The Preview Panel display is based on the item selected in the grid.

Highlighting a folder or node on the Tree View also changes the options available from the Action menu. To access specific Action menu items, you must ensure the correct folder or node is highlighted in the Tree View. Note that some Action menu items display sub-menus.

Action Menu
Use the Action Menu to enter information or complete a task in SSIS. The Action menu is available from four locations in SSIS:
1. The Action Button at the bottom of most windows.
2. The Lightning Bolt Quick Add button on the Tree View Toolbar.
3. The Paper icon in the Tree View toolbar.
4. Right-clicking on the folder or node in the Tree View or in a grid.

Before you move off a folder or node in the Tree View, access the Action menu to view prompts for any additional information you should enter.
Getting Help in SSIS
There are three ways to find help in SSIS:
  • What’s New? in SSIS
  • Contents Help
  • Hyperlinks.

What’s New?
What’s New? in SSIS allows you to view version changes and enhancements to the application.

From the Windows toolbar, select Help. Then select What’s New? For a complete list of updates, select the appropriate version number. The list of updates displays for the current version.

Contents
Select Contents to locate topic-specific help for the SSIS application. Click on the Find tab; the Find search opens. Choose a topic to search, and then click Display to view the information.

Hyperlinks
Hyperlinked help text located under blue, underlined text displays in various areas of the application. Following the link provides helpful information to assist with various functions of the application.

Summary
You now have a good understanding of basic screens and navigation using toolbars, the Task Panel and the Action Menu. When you develop proficiency using these tools, you can navigate anywhere in the application.

SSIS as a Case Management Tool
In your agency role, you may manage a variety of cases and work with many children, youth and families. Next, you begin to think of SSIS as more than a data entry requirement; you begin to recognize it as an effective case management tool that helps you sort and track your client contacts and activities.

In this section you develop a basic understanding of:
  • Cases
  • Workgroups
  • Participants
  • Searches.

Cases and Workgroups
Your client work in SSIS is organized by Cases and Workgroups.
The Case is the container that holds all Workgroups associated with one household or family. Generally, there is one Case per family.

Within the Case there may be any number of Workgroups. A Workgroup must have at least one worker providing one service to one client in one DHS program area. The Workgroup is what most case workers consider a case file.

**How are Cases and Workgroups named?**

DHS best practice is to name the Case after the female head of household. If there is no female head of household, next choice is male head of household, and then eldest child.

There is no best practice for naming a Workgroup. Naming conventions differ with program area requirements. Consult with your supervisor for naming standards in your agency.

It is important to realize that the Case folder can only be viewed by selecting “Open With Case in New Window” from your Caseload List, from View County Detail, or from the Associated Workgroups folder under an Intake or Workgroup. Once the Case folder is open, you may find useful information to assist your work with this client or family.

Recall that there can be multiple Workgroups within a Case depending on the types and number of services a household is receiving. Each Workgroup may contain different participants

**Participants**

There are three different types of Participants in SSIS: Client, Collateral and Professional Collateral. Participants are found under the Participants folder in the Tree View.

A client is a person receiving services from your agency. Clients are searchable. The majority of information entered into SSIS is associated with the client. Client information is viewable under all Workgroups associated with that client.

Collaterals are people of significance in the Case, such as a neighbor or a teacher, who may provide support to the family or provide information to you. Collaterals do not receive direct services. Collaterals are not searchable and are only viewable in the Workgroup in which they were entered.

Professional Collaterals are service providers. They are generally not known on a personal level to the family, and may be paid for their services. A Professional Collateral is differentiated from a Collateral by the Business Card icon, found in the Education/Employment folder. The Business Card icon indicates that the place of employment has been entered, and “Use for Professional Search” has been selected.

**Search for Information**

Now that you have a basic understanding of terminology, let’s look at how you find information. Best Practice is to locate *existing* information, historical or current, in SSIS.
Everything starts with a search. Searching, before you do anything else, can provide information such as:

- Does the family have a current active workgroup with another worker?
- Has a family member received services in the past?
- Has the family received services in another agency?
- Has a specific professional collateral already been entered?

There are many other reasons to search first. Most importantly, searching saves you time and effort, and helps keep SSIS accurate.

Frequently used searches are:

- Person Search – search for clients and professional collaterals.
- Intake Search – search for current and prior intakes.
- Workgroup Search – search for your workgroups or colleagues’ workgroups.
- Business Organization Search – search for local law enforcement, area schools or foster care homes entered by your agency.
- Licensed Provider (LNDX) Search – search for state-licensed providers.
- Service Arrangement Search – search for current or past service arrangements.
- Healthcare Claim Search – search for submitted or pending Healthcare claims.
- Payment Search – search for pending or paid payments for services.

Your first step when working with children and families is to gather basic client information, search for existing information, and update that information in SSIS. Searching for information first helps you avoid duplicate entry and effectively manage your time.

Client searches are done within either the State or County scope. Search the State scope first.

The State scope is called the Statewide Index or SWNDX. SWNDX is a collaborative effort with SSIS, MAXIS, MMIS and PRISM to combine basic demographic information about clients. Note that you may only search for client demographic information using SWNDX. Your agency database will have more information about your client than SWNDX.

To gather information on a client receiving services from another county or tribe, you can view the case and workgroups in the other agency by using Statewide Case Access.

When you work with clients and families, you ask questions to gather or verify basic information at specific points during intake, assessment and case management.

**Scenario**

The following scenario presents a social worker/client interaction, followed by guidance on adding information to SSIS.

Maggie, the mother in this case, has told us she has a new stepson. We have already searched for and added Maggie and her other children, Sarah and Kate, into their workgroup. We want to put the stepson’s client information into the workgroup.
Social worker: Maggie, let's confirm some basic information. First, how do you spell your stepchild’s name?
Maggie: Sure. It’s Terry Lee Williams. Terry is spelled T-e-r-r-y. And Lee, L-e-e.
Social worker: Terry is a boy, right? Your stepson?
Maggie: Yes, Terry’s a boy.
Social worker: What’s his birthdate?
Maggie: April 1, 1998.

Enter the information Maggie provided regarding her stepson, Terry, into the existing workgroup. Open your caseload list by going to the Workgroup Search.
1. Expand the My Caseload node.
2. Select the Kate Merriweather CMH assessment workgroup.
3. Access your Action menu and select Open With Case in New Window.
4. The Kate Merriweather CMH Assessment workgroup opens under the Maggie Merriweather Case. Expand the Workgroup node.

We have already searched and not located Terry in either SWNDX or the agency database. We want to add Terry Williams (Maggie’s stepson) as a New Client.
1. Expand the Participants folder. Access the Action menu and select New Client.
3. Enter Terry’s first, middle and last name.
4. Select Uncleared Client as Terry’s Clearing Status.
5. Select his Gender.
6. Enter his date of birth in the DOB field.

The interview with Maggie continues.
Social worker: Do you know Terry’s Social Security Number? 
Maggie: I have it right here.
Social worker: Is he a US Citizen?
Maggie: Yes.
SW: Is English his primary language?
Maggie: Yes.
SW: Maggie, does Terry have Hispanic heritage?
Maggie: Yes.
SW: Does your family also speak Spanish?
Maggie: Yes, we do.
SW: So, would you feel more comfortable with an interpreter?
Maggie: No, thank you. We’re okay; we don’t need an interpreter.
SW: Can you tell me whether Terry has American Indian heritage?
Maggie: Yes, he does.
Social worker: Maggie, I need to provide you a Notice of Data Privacy Practices; I’ll also talk to Terry about this when I meet with him.

It’s good practice to ask about interpreters and translators, initially and at points throughout your work with a family.
Continue with SSIS data entry:

1. Enter the client’s social security number in the SSN field.
   You can click into a screen to make it editable. When a field displays as gray it is not editable.
2. Enter the client’s US citizenship status – remember, Terry is a U.S. citizen.
3. Enter the client’s Verification method. Clients may provide an array of acceptable documents, or a client or client’s parent or caretaker may state citizenship status.
4. Enter the date that the citizenship became effective in the U.S. citizenship date field. When the status of U.S. Citizen/naturalized citizen is selected along with the verification method of Birth Certificate the U.S. Citizenship date will autofill to the client’s date of birth.
5. Enter the date citizenship was verified in the Date verified field. Although it is helpful to have as much information documented into SSIS as possible, citizenship is only a required entry for children in placement, for foster parents and for pre-adoptive parents.
6. Select English as Primary Language
7. Select No for Interpreter services needed.
8. Select the client’s Marital Status.
9. Select the client’s ICWA status.

Now that you have completed entry on the Person Information tab, return to the top of the screen and click on the Workgroup Information tab.

1. Select Yes for the Privacy practices notice. We were able to explain this to Terry when he came in from the waiting room during our meeting with his stepmother.
2. Select Written in Notice type; we could also have select Verbal here.
3. Enter the correct date in the Notice date field.

**Relationships**
When you interview clients, ask about the relationships between all family members. A relationship is defined as a familial connection between two people.

Relationships are important in SSIS:
- Relationships follow the client to any additional current or future workgroups and need be entered only once.
- Relationships entered in any agency remain associated with the client.
- Relationships entered are reciprocal; a relationship needs to be entered for only one client to display for the other.
- Children in placement must have family relationships established when permanency goals of adoption or transfer of legal guardianship are established.
- Relationships can be inactivated due to such things as termination of parental rights, divorce or death.
- Some SSIS features are available to caseworkers (such as copying a placement for sibling groups, or copying a service plan), but only if relationships are entered.
In your work you would want to enter all familial relationships. While updating client information for Terry, make sure we enter his relationship to his stepmother.

To Create a New Relationship:
1. Expand Terry’s Client node.
2. Select the Relationship folder.
3. Access the Action menu.
4. Select New Relationship.
5. The Relationship screen displays. Select stepparent as the type of relationship from the Relationship field drop-down menu.
6. The type of relationships are gender neutral until a person is selected in the Person 2 field.
7. Select Maggie Merriweather as Person 2.

Once all three fields have been completed, a sentence displays below the relationship fields describing the nature of the relationship. This can assist you with selecting the correct relationship. Save the information when it has been entered accurately.

To enter more than one relationship to an individual, access the Action menu and select New Relationship. A new relationship node displays in the Tree View and in the Relationships grid. Checking that a new relationship node displays confirms that you are creating a new relationship and not just overwriting what had previously been entered.

Relationships are reciprocal and need to be entered under only one client node to display under both client nodes. There are other functions within SSIS that rely on the entry of relationship information. As a worker you will find other tasks made easier by entering relationship information early.

Summary
In this section, you learned basic terminology including case, workgroup and participant (client, collateral and professional collateral). And you are beginning to understand searches and creating relationships in SSIS. In addition, you realize the importance of always searching first before you begin to enter new information.

Timeline and Entry Requirement Tools
In your work with children and families, you have many tasks to complete – and some have very specific deadlines. SSIS provides tools to help you manage case timelines and entry requirements, and free you up from creating your own system of lists and calendars.

In this section you get a basic understanding of managing casework timelines and entry requirements using:
- SSIS Reminders and Alerts
- Data Clean-up
- Mandatory Field Indicators.
SSIS helps you follow federal and state mandated child welfare and adult maltreatment timelines by sending Reminders and Alerts related to the program area of your workgroup to the Primary Worker. Each worker can only view their own Reminders and Alerts.

**Alerts**
Alerts are system-generated nightly and are removed from your Reminders and Alerts Log nightly, once an action is taken that satisfies the alert. Alerts are generated in advance of the due date, and provide you time to satisfy the Alert.

To satisfy the Alert: select it in the grid, access the Action Menu, and select Open Workgroup. This takes you to the workgroup so you can complete the action required in the Alert. Alerts are generated nightly. When you complete an alert today it is removed from your Reminders and Alerts Log the next morning.

**Reminders**
There are two types of reminders: SSIS Reminders and User Reminders.

SSIS Reminders are system-generated every 10 minutes and are triggered by various events associated with your client’s workgroup. SSIS Reminders are removed from the log when they are deleted by you.

To view the workgroup information indicated in the SSIS Reminder, access the Action menu, then select Open Workgroup. Navigate to the area indicated in the Reminder. Expand the workgroup and enter information to satisfy the Reminder.

The User Reminder is created by you and might include workgroup or client-specific reminders. Like SSIS Reminders, User Reminders are only removed from your log when they are deleted by you.

To create a new reminder, select New Reminder from the file menu in the Windows Toolbar. Or from the Reminders and Alerts Log, click the Action button, and select New Reminder. A New Reminder screen displays. Create your reminder, and click OK to save.

You can also create reminders for non-client events, like this team meeting reminder.

**Data Clean-up**
In addition to the Reminders and Alerts Log, SSIS uses Data Clean-up to help you follow program-specific timelines, system business rules and enter mandated information.

Data Clean-up is used to identify missing or incomplete information required for reporting or closing the workgroup. Data Clean-up displays errors for required data, such as for AFCARS, NCANDS, Adult Maltreatment and the Elementary and Secondary Education Act (ESEA).

Data Clean-up can be accessed from the Intake Workgroup node, the Assessment or Case Management Workgroup node, the Child Maltreatment Report node, Adult Maltreatment Report node, Participants folder and Client node.
Best Practice is to run Data Clean-up from the Workgroup folder, which includes all data clean-up errors.

To Access Data Clean-up:
1. Select the Workgroup folder.
2. Access the Action menu.
3. Select Data Clean-up.

The fastest way to access Data Clean-up is to press the F8 key on your keyboard.

The Data Clean-up tab displays. Errors are located within the corresponding folder or node. Click on the Chevron to display errors. Clicking once on an error:

- Displays the Error Help section at the bottom of the screen, describing the error to be satisfied
- Brings you to the appropriate screen where you can satisfy the error.

Additional descriptions of the error may display in the Error Help section.

Once an error is satisfied, it continues to display until the folder or node is refreshed.

To refresh Data Clean-up:
- Click on the chevron to collapse all errors.
- Click on the chevron again to expand all errors. The error just satisfied no longer displays.

Sometimes new errors display after you have refreshed Data Clean-up.
For example if a child client is identified as qualifying under ICWA, a new or additional race entry must include American Indian/Alaskan Native, or a new error displays.

Click once on the new error. The appropriate screen displays; from the drop-down menu, choose American Indian/Alaskan Native.

Before closing Data Clean-up, refresh errors to verify that no new errors display.

You can click on the Tree Tab to leave Data Clean-up available. Or, to close Data Clean-up, simply press the F8 key.

**Mandatory Field Indicators**
Like Data Clean-up, Mandatory Field Indicators help you follow program-specific timelines, system business rules and enter mandated information. Mandatory Field Indicators display throughout SSIS, guiding completion of fields.

A **red** Mandatory Field Indicator signals that the field must be completed before you can save the screen.
A yellow mandatory field indicator signals that the field must be completed, but the screen may be saved and you may move to a new screen. However, entering the information is mandatory and will impact later work.

A red squiggly line displays when information entered has broken a business rule. For example, you may not enter a start date that is in the future when you are entering an Intake.

A flyover provides information on the mandatory field indicator. Simply place your cursor over the field and the flyover displays.

Summary
Use Alerts, Reminders, Data Clean-up and Mandatory Field Indicators to help you manage timelines and entry requirements.

SSIS Learning Resources
As you have seen, SSIS provides visual cues and on-screen support. In addition, there are a variety of learning resources and support options provided by your agency, SSIS staff and DHS.

In this section you will discover SSIS learning resources including:
• Classroom training
• Agency Coordinators
• Agency Mentors
• Web-based Resources
• Computer-based or web-based training.

Classroom Training
SSIS classroom training includes, but is not limited to:
• Child Welfare Foundation Training
• SSIS Release Training
• SSIS New Worker for Fiscal and Worker Training
• VA-CEP Training
• SSIS Adoptions Training.

To find out more, consult:
• SSIS Implementation memos
• The SSIS Update
• TrainLink
• Your supervisor or SSIS Mentor.

Agency Coordinators
Each agency has an SSIS Coordinator who serves as the liaison between your agency and SSIS staff at DHS. Your Coordinator distributes information about new releases, uploads data and offers your agency’s perspective on design, development and workflow of SSIS.
Ask your supervisor to identify your agency SSIS Coordinator. Your Coordinator may also be your SSIS Mentor.

**Agency Mentors**
Most agencies have at least one SSIS Mentor to support you. Your Mentor provides supplemental and refresher training, assists with problem-solving, provides SSIS navigation skills, clarifies error messages and helps you correct errors. The Mentor contacts the SSIS Help Line with suggestions, enhancement requests, error reports and network difficulties.

**Web-based Resources**
The SSIS Training Website provides access to written documentation and online training. You can copy and paste this address into your web browser’s address bar:
Add the link to your Favorites and check back regularly.

Policy and program resources are available through CountyLink.

For assistance with web-based resources, consult your SSIS Mentor or supervisor.

**Web-based Training**
Along with WBTs, live and recorded webinars specific to your job duties may be available. Webinar presentations focus on what’s new in SSIS, clarify SSIS changes, and are helpful refreshers. Ask your SSIS Mentor, Coordinator or Supervisor for more information regarding these learning opportunities.

**Summary**
As you learn to use SSIS, be aware that you have a variety of learning resources at your disposal. Be sure to take advantage of classroom and web-based training, utilize your agency Coordinator and Mentors, and access web-based resources.

**Next Steps**
Continue to build your training binder with documents and printouts from this chapter. File this chapter transcript behind the Module 2 Transcript tab.

Handouts are available on the SSIS website at
http://www.dhs.state.mn.us/main/idcplg?IdcService=GET_DYNAMIC_CONVERSION&RevisionSelectionMethod=LatestReleased&dDocName=id_000477. Print the handouts that may be helpful in your work, or bookmark the page for future reference.
- SSIS Combined Glossary of Terms Job Aid
- SSIS Navigation Guide/Glossary Job Aid
- Getting Help in SSIS Job Aid
- SSIS Reminders and Alerts Definitions Job Aid.
Consult with your supervisor regarding:
- Agency-specific data entry requirements
- Naming conventions for workgroups
- SSIS training opportunities, including webinars
- Identification of your agency Coordinator and Mentor.

When you are ready, begin Chapter 2.